CAPITOLUL 3

Utilizarea obiectelor 3D in scene statice

3.1. Fisiere .OBJ

Formatul de fisier OBJ este unul dintre cele mai importante formate de fisiere 1n aplicatiile de
imprimare 3D si graficd 3D. Este formatul preferat pentru imprimarea 3D multicolor si este utilizat
pe scard larga ca format de schimb neutru pentru modelele 3D non-animate in aplicatiile grafice.

Un fisier OBJ este un format standard de imagine 3D care poate fi exportat si deschis de
diverse programe de editare 3D. Acesta contine un obiect tridimensional, care include coordonatele
3D, hartile de texturi, fetele poligonale si alte informatii despre obiect.

Pe scurt, formatul de fisier OBJ stocheazad informatii despre modelele 3D. Poate codifica
geometria suprafetei unui model 3D si poate stoca, de asemenea, informatii despre culoare si textura.
Acest format nu stocheaza nicio informatie despre scend cum ar fi pozitia luminii sau animatii.

Un fisier OBJ este de obicei generat de un software CAD (Computer Aided Design) ca produs
final al procesului de modelare 3D. Extensia de fisier corespunzitoare formatului de fisier OBJ este
pur si simplu ,,.OBJ”.

Formatul de fisier OBJ este open source si neutru. Este adesea utilizat pentru partajarea
modelelor 3D in aplicatii grafice, deoarece se bucura de un bun suport de import si export din aproape
toate software-urile CAD. Acesta este de asemenea utilizat ca format de fisier pentru imprimarea 3D
multicolor, deoarece formatul standard de imprimare 3D STL nu include informatii despre culoare si
textura.

Formatul de fisier OBJ a fost creat initial de Wavefront Technologies pentru aplicatia sa
Advanced Visualizer pentru a stoca obiecte geometrice compuse din linii, poligoane si curbe si
suprafete de forma libera. Cea mai recentd versiune documentatd este v3.0, Inlocuind versiunea
anterioard v2.11.

Cel mai dominant format din lumea tiparirii 3D este STL. Cu toate acestea, STL este un format
de fisier vechi care, desi este foarte popular, nu a tinut cont de cerintele moderne. Exactitatea
imprimarii 3D se apropie rapid de rezolutia la nivel de micron si modelele multicolore devin din ce
in ce mai populare. Formatul de fisier STL nu poate suporta destul de bine rezolutiile mari, deoarece
o rezolutie mai mare duce la cresterea dimensiunii fisierului. De asemenea, formatul STL nu este
potrivit pentru imprimarea 3D multicolor, deoarece nu suporta informatii despre culoare si textura.
In schimb, formatul OBJ poate aproxima geometria suprafetei destul de precis, fara a avea un impact
semnificativ asupra dimensiunii fisierului. Acest lucru este posibil folosind curbele Bezier si 0 metoda
numitda NURBS. In plus, formatul de fisier OBJ are suport nativ pentru mai multe culori si texturi din
acelasi model.

Astfel, utilizarea formatului OBJ are o0 serie de avantaje in comparatie cu utilizarea formatului
STL in cazul in care aveti nevoie de modele cu rezolutie inalta, multi-color. Pe de alta parte, formatul
de fisier OBJ nu este la fel de universal ca formatul STL. Aproape toate imprimantele 3D accepta
formatul STL. Nu se poate spune acelasi lucru si despre formatul OBJ, chiar daca se bucura de suport.
Prin urmare, daca este nevoie de a tipari un model 3D monocrom la o imprimantd standard, este
preferabil formatul STL.

Ambele formate OBJ si STL au un spectru larg de utilizare, cu o baza mare de utilizatori fideli
si se bucura de suportul unei multimi de aplicatii terte.

Concurentii principali in cazul formatelor de fisiere pentru imprimare 3D sunt VRML, AMF
si 3MF, care insa nu se bucura de un asa suport si compatibilitate si deci nu sunt alternative serioase
ale formatelor de fisiere STL si OBJ.

Format fisier OBJ se utilizeaza in aplicatii grafice 3D. Cele mai utilizate formate de fisiere in
aplicatiile 3D Graphics sunt OBJ, FBX si COLLADA.

Diferente intre formatele de fisiere OBJ, FBX, COLLADA

Cea mai importantd diferentd intre formatul de fisier OBJ si celelalte doua (FBX si
COLLADA) este suportul pentru informatii despre scend cum ar fi sursele de lumind si animatii.
Formatul de fisier OBJ nu contine informatii despre scene si animatii, in timp ce FBX si COLLADA
o fac. Prin urmare, daca se doreste intretinerea suportului pentru animatii in cazul jocurilor sau
filmelor, atunci se recomanda utilizarea formatului FBX sau COLLADA. Tn cazul in care insa nu este
nevoie de o scena complexa sau de animatii, poate fi argumentata utilizarea formatului de fisier OBJ.



Avantajele formatului obj

In primul rand, formatul de fisier OBJ este un format simplu si deschis. Are suport larg pentru
export si import printre software CAD. Aceasta inseamnd cd daca partajati modelul 3D ca fisier OBJ,
atunci alte programe CAD il vor interpreta corect si consecvent. Nu se poate spune acelasi lucru
despre formatele FBX sau COLLADA. Formatul COLLADA este, de asemenea, open source, dar
este destul de complicat. Diferite software CAD 1l interpreteaza diferit si acest lucru poate duce la
erori.

Formatul FBX este un format inchis si proprietar si oferd un SDK pentru conversia formatelor
existente in FBX. Convertirea unui fisier FBX intr-un alt format insa se realizeaza destul de complicat
si poate fi insotita de aparitia erorilor.

Un fisier OBJ va fi, mult mai simplu si de dimensiuni reduse comparativ cu un fisier FBX sau
COLLADA care contin acelasi model 3D. Acest lucru se datoreaza simplitatii formatului de fisier
OBJ in comparatie cu celelalte specificatii si datoritd codificarii sale binare native.

Astfel, daca nu este nevoie de 0 scena complexa sau de animatii si dar mult mai mult conteaza
suportul si interpretare corecta de diferite software CAD, formatul de fisier OBJ este formatul potrivit.
In aproape toate celelalte cazuri, FBX este formatul optim pentru aplicatiile grafice 3D.

Caracteristici moderne a formatului de fisiere obj

Tn ceea ce priveste caracteristicile moderne, formatul FBX este cel mai progresiv format care
ofera o multime de caracteristici de ultima generatie, actualizari si imbunatatiri regulate. Formatul de
fisier OBJ este al doilea in ceea ce priveste caracteristicile, in timp ce formatul COLLADA nu se
bucura de actualizari si imbunatatiri regulate.

Geometrie

Scopul principal al formatului de fisier OBJ este de a codifica geometria suprafetei unui obiect
3D. Formatul de fisier OBJ este destul de versatil in acest sens. Permite mai multe optiuni pentru
codarea geometriei suprafetei. Fiecare dintre cele trei metode permise descrise mai jos au propriile
avantaje si dezavantaje.

Teselare cu fete poligonale

In forma sa cea mai simpla, formatul de fisier OBJ permite utilizatorului s teseleze suprafata
modelului 3D cu forme geometrice simple precum triunghiuri, patrulatere sau poligoane mai
complexe. Varfurile poligoanelor si normala fiecarui poligon sunt apoi stocate intr-un fisier care
contine geometria suprafetei modelului.

Teselarile cu fete poligonale au 0 serie de avantaje si dezavantaje. Poligoanele sunt forme
geometrice simple si aceastd metoda este de fapt cel mai simplu mod de a descrie geometria
suprafetei. Cu toate acestea, aproximarea unei suprafete curbate cu poligoane duce la modificarea
grosimii modelului.

In cazul tiparirii 3D, imprimanta 3D va imprima obiectul cu aceeasi grosime specificati de
fisier. Desigur, facand triunghiurile din ce in ce mai mici, aproximarea poate fi facutd din ce in ce
mai exact, rezultand imprimari de o calitate mare. Cu toate acestea, pe masura ce Se micsoreaza
dimensiunea triunghiului, creste si numarul de triunghiuri necesare pentru a descrie suprafata. Acest
fapt cauzeaza cresterea semnificativa a dimensiunii figierului, problema care incearca sa 0 solutioneze
slicer-ele de imprimare 3D. De asemenea, devine dificila distributia sau gestionarea unor astfel de
fisiere uriase.

Prin urmare, este foarte important sa se gaseasca echilibrul corect intre dimensiunea fisierului
si calitatea imprimarii. Nu are sens sa se reduca dimensiunile triunghiurilor la infinit, deoarece la un
moment dat nu se va mai putea distinge cu ochiul liber diferenta intre calitatile tiparirii.

Extensia de fisier .obj se refera in primul rand la Wavefront 3D (.0bj) dezvoltat de Wavefront
Technologies pentru software-ul Advanced Visualizer. Formatul OBJ este un format textual pentru
descrierea geometriei corpurilor tridimensionale care permite modelarea formelor volumetrice
complexe si aplicarea diverselor materiale si texturi. Pe langa fisierul .OBJ, un obiect sau scena tipica
Wavefront 3D va include, de obicei, unul sau mai multe fisiere Material Template Library (.mtl), care
definesc materialele obiectului cu referinte la texturi de tip bitmap externe, de obicei stocate intr-un
subdirector separat.



Formatul OBJ a devenit unul dintre cele mai populare si acceptate formate de modele 3D si
functiile de export/import de fisiere .OBJ sunt prezente in aproape fiecare editor 3D. Destul de multe
utilitare pentru vizualizarea modelelor 3D (exista chiar si aplicatii web care permit importul,
vizualizarea, editarea, exportul si conversia fisierelor .OBJ) ofera posibilitatea de a deschide fisiere
.OBJ si a afisa modelele continute cu redare completa, iar o serie de convertoare permit conversia
modelelor OBJ in alte formate. Exista colectii intregi si biblioteci de modele in acest format pe
Internet. Formatul de geometrie OBJ este un format deschis pentru fisierele de descriere a geometriei.

Specificatie OBJ

Formatul de fisier OBJ este un format de fisier ASCII. Editarea acestuia poate fi realizatd cu
ajutorul oricarui editor de text.

Specificatia originald nu indica explicit care ar trebui sa fie caracterul de sfarsit de linie, asa
ca unele software-uri folosesc \r retur de car (CR) si altele folosesc \n linie noud (NL sau LF). Este
posibil sa fie necesara conversia caracterelor care indica sfarsitul de linie daca editorul dvs. de text
sau software-ul utilizat nu reusesc sa citeasca fisierul.

Primul caracter al fiecarei linii este foarte important deoarece acesta Specifica tipul de
comanda. Daca primul caracter este #, acea linie reprezinta un comentariu si orice altceva din acea
linie este ignorat. Liniile goale sunt, de asemenea, ignorate.

Comanda comentariu

# o linie de comentarii

Dupa cum S-a mentionat anterior, caracterul # indica faptul ca linia reprezinta un comentariu
si ar trebui ignoratd. Prima linie este de obicei intotdeauna un comentariu care specificd ce program
a generat fisierul.

Comanda varf

VXYyZ

In aceastd versiune simplificata a specificatiei, vor fi cuprinse doar fetele poligonale, prin
urmare comanda vertex — v poate fi utilizatda pentru a specifica varfurile poligonului. Cand se
utilizeaza suprafete si curbe de forma liberd, existd o comanda similara vp care poate fi utilizatd
pentru a specifica punctele de control ale suprafetei sau curbei.

Comanda vertex — v specifica un varf prin cele trei coordonate carteziene X, y si z. Varfului i
se atribuie automat un nume in functie de ordinea in care este gasit in fisier. Primul varf din fisier
primeste numele ,,17, al doilea ca ,,2”, al treilea ca ,,3” si asa mai departe.

Comanda normala la varf

VN Xy z

Vertex normal — vn este comanda pentru normala unui varf. Specifica vectorul normal la
suprafata. Parametrii X, y si z sunt componentele vectorului normal. Acest vector normal nu este inca
asociat niciunui varf. Acesta va trebui sa fie asociat ulterior unui varf cu ajutorul unei alte comenzi
numita comanda f.

Comanda vertex normal poate fi omisa intr-o multime de fisiere, deoarece atunci cand se vor
grupa varfurile in fete poligonale cu comanda f, se va determina automat vectorul normal din
coordonatele varfului si ordinea in care vor aparea varfurile.

Comanda textura a varfului

vtuv [w]

Comanda vertex texture — vt specifica un punct din harta texturilor. Parametrii u si v sunt
coordonatele x si y din harta texturii. Acestea vor fi numere in virgulda mobila intre 0 si 1. Acestea
trebuie asociate unui varf cu ajutorul comenzii f, analogic normalelor la varfuri.

Comanda suprafata

fvl[/vtl] [/ vnl] v2 [/ vt2] [/ vn2] v3 [/ vt3] [/ vn3] ...

Comanda suprafata — f este probabil cea mai importantd comanda. Specifica o suprafata
poligonala creata din varfurile specificate anterior.

Pentru a face referire la un varf, trebuie doar urmat sistemul de numerotare implicit al
varfurilor. De exemplu, ,,f 23 24 25 27” descrie o fata poligonala construita din varfurile 23, 24, 25
si 27 in ordine.



Pentru fiecare varf, se poate asocia o comanda vn, care apoi asociaza acel normala cu varful
corespunzitor. In mod similar, poate fi asociatd o comanda vt cu un varf, care va determina maparea
texturii utilizate pentru acest varf.

Daca se indica textura sau normala pentru un varf, atunci acestea trebuie specificate pentru
toate.

Comanda grup

g nume

Comanda grup — g indica gruparea unei parti a obiectului intr-un grup cu numele indicat ca
parametru. Toate comenzile f care urmeaza vor fi in incluse in acelasi grup. Acest lucru este util daca
se doreste reutilizarea unei anumite informatii, cum ar fi tipul de material, pentru o parte selectatd a
unui obiect.

Comanda material utilizat

nume usemtl

Comanda de utilizare a materialului — usemtl permite indicarea materialului utilizat. Toate
comenzile f care vor urma vor folosi acelasi material pana nu apare o altd comanda usemtl.

3.2 Biblioteca de materiale

Informatia despre aspectul obiectelor (materialelor) continute in figierul OBJ se contine in
fisiere separate in format MTL (Material Library). Fisierul OBJ face referinta la un astfel de fisier,
daca este necesar, folosind directiva:

Mtllib [numele fisierului extern MTL]

MTL este un standard stabilit de Wavefront Technologies. Toate informatiile sunt prezentate
in forma ASCII si sunt lizibile pentru om. Standardul MTL este, de asemenea, foarte popular si este
acceptat de majoritatea pachetelor grafice 3D.

Informatiile despre materialele simple din fisier arata astfel:

Newmtl material _namel

# Anuntarea urmatorului material

# Culori Ka 1.000 1.000 0.000

# Culoare lumina ambientald (galben) Kd 1.000 1.000 1.000
# Culoare difuza (alb)

# Parametri de reflectie Ks 0.000 0.000 0.000

# Culoare reflexie speculara (0; 0; 0 - oprit) Ns 10.000

# Coeficient de reflectie speculara (de la 0 la 1000)

# Parametri de transparenta d 0.9

# Transparenta este specificata folosind directiva d Tr 0.9
# sau in alte implementari de format folosind Tr

# Urmatorul material newmtl material name? ...

Toti parametrii sunt optionali. In absenta oricirui parametru, programul il seteazi automat in
mod implicit.

Avand n vedere toate cele expuse anterior, mai jos este prezentat continutul unui fisier OBJ
simplu (CUB) construit in editorul 3D Google SketchUp, (fig. 3.1) si exportat ca fitier .OBJ cu
ajutorul plugin-ului LIPID Lightsolve care poate fi usor gasit si instalat din meniul
Window>Extemsion Warehouse. Pentru a avea posibilitate de a instala oricare plugin din biblioteca
de extensii utilizatorul trebuie sa dispuna de un account Google si sa fie autentificat.
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Fig. 3.1. Modelul 3D a unui cub construit in editorul 3D Google SketchUp
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Pentru a exporta modelul 3D al cubului in formatul OBJ se acceseaza: File-> LIPID OBJ
Exporter, (fig. 3.2), apoi in fereastra LIPIDOBJ se bifeaza optiunea Ignore Back face.
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Fig. 3.2. Exportarea modelul 3D al cubului in formatul OBJ cu ajutorul plugin-ului LIPIDOBJ

Continutul figierului .OBJ a modelului 3D a cubului prezentat in figura 3.2:
mtllib /Cub.mtl
sl

0

g

usemtl 0020_Red
v 1001000
v00O

v 01000
vn00-1

f1//1 2111 3/11



v10000
f2//11//1 4//11
v 100 0 100

v 0100 100
v00 100
vn001

f5/12 6/12 7112
v 100 100 100
f6//2 5112 8112
usemtl 0076_Green
vn0-10
£5/13 2113 4113
f2//35/13 7113
vn010

f6//4 1//4 3//4
f 1//4 6//4 8//4
usemtl 0103_Blue
vn-100
f6//5 2//5 7115
f 2//5 6//5 3/I5
vn100

f 1//6 5//6 4116
f5//6 1//6 8//6

Analizand continutul fisierului .OBJ prezentat anterior se poate observa faptul ca in figierul
Cub.obj este utilizat fisierul de materiale Cub.mtl care se afla in acelasi. Pe langa aceasta mai poate
fi observata descrierea coordonatelor tuturor celor 8 varfuri ale cubului, indicarea suprafetelor
(triunghiurilor) care alcatuiesc cele 6 fete ale cubului cu specificarea normalelor acestora si atribuirea
texturilor 0020_Red, 0076_Green si 0103_Blue suprafetelor (triunghiurilor) corespunzatoare.

Continutul fisierului materialelor utilizate pentru texturarea modelului 3D a cubului prezentat
n figura 3.2.

#

## Alias MTL Material File

# Converted from SKP by LIPID Lightsolve

newmtl 0020_Red

Ka 0.000000 0.000000 0.000000

Kd100

Ks 0.330000 0.330000 0.330000

newmtl 0076_Green

Ka 0.000000 0.000000 0.000000

Kd 0 0.501961 0

Ks 0.330000 0.330000 0.330000

newmtl 0103_Blue

Ka 0.000000 0.000000 0.000000

Kd001

Ks 0.330000 0.330000 0.330000

newmtl default_material

Ka 0.000000 0.000000 0.000000

Kd 0.330000 0.330000 0.330000

Ks 0.330000 0.330000 0.330000

Analizand continutul fisierului .MTL prezentat anterior poate fi observata definirea texturilor
0020_Red, 0076_Green si 0103_Blue utilizate in fisierul Cub.obj pentru texturarea fetelor modelului
cubului.



Descrierea obiectelor si metodelor principale pentru lucrul cu fisiere .OBJ cu ajutorul
librariei pentru realizarea graficii WEB tridimensionale in editorul online p5.js

Biblioteca p5.js este o biblioteca JavaScript care usureaza procesul de dezvoltare a
programelor ce utilizeaza elemente grafice 2D si 3D si este destinatd atat pentru dezvoltatorii
experimentati Cat si pentru incepatori. Biblioteca p5.js este gratuita si open-source.

Biblioteca p5.js are un set complet de functionalitati grafice. Cu ajutorul acestei biblioteci
grafice intreaga pagind a browserului este privita ca spatiu de lucru in care pot fi utilizate inclusiv
obiecte HTMLS5 pentru text, video, camera web si sunet.

Functiile de baza:

Incdrcarea unui model 3D dintr-un fisier OBJ sau STL.

loadModel() trebuie plasat in interiorul functiei preload(). Acest lucru permite modelului sa se
incarce complet inainte de a rula restul programului.

Una dintre limitarile formatului OBJ si STL este faptul ca nu tine cont de scara. Aceasta
inseamna cd modelele exportate din diferite programe pot avea dimensiuni diferite. Dacd modelul nu
se afiseaza, incercati sa apelati loadModel() cu parametrul de normalizare setat la true. Aceasta va
redimensiona modelul la o scara adecvatd pentru p5. De asemenea, se pot face modificari
suplimentare ale dimensiunii modelului cu functia scale().

De asemenea, nu este realizat suportul pentru fisiere colorate STL. Fisierele STL colorate vor
fi redate fara proprietati de culoare.

Sintaxa:

loadModel (path, normalize, [successCallback], [failureCallback], [fileType])

loadModel (path, [successCallback], [failureCallback], [fileType])

Parametri:

path String: Calea modelului incarcat

normalize boolean: daca este adevarat, se scaleaza modelul la o dimensiune standard la incarcare
functia successCallback Function(p5.Geometry): functie care trebuie apelatd dupd incarcarea
modelului. Va fi returnat obiectul de tip 3D model. (Optional)

functia failureCallback Function(Event): apelat cu eveniment de eroare daca modelul nu reuseste sa
se incarce. (Optional)

fileType String: extensia fisierului modelului (.stl, .obj). (Optional)

Se intoarce

p5.Geometry: obiect de tip p5.Geometry

model()
Reda un model 3D pe ecran.

Sintaxa:

model(model)

Parametri:

model p5.Geometrie: Model 3D incarcat care trebuie redat
Sketch Files->Upload file



@) Mail-C x ¢ M x Obj—E X Object F X x X | "N MILEc X | & Creatifc x | G OBJFile X pSjsWe X 4

& (] @ editor.p5js.org Y % Incognito

t Gmail B Maps = Registru evidenta C.. @ GISMETE: Moroga-. H® XpowikaXaoca|P.. R ESPI2-CAM Video.. [ Transistor base resi.. () SketchUp » | W Other bookmarks Reading st

» | ] B Auto-refresh ¢
Sketch Files v €  sketchjs
Create folder
Create file

Upload file

O{
(600, 500,
O;
(fry;

(O

Console

Fig. 3.3. Incércarea fisierului Cub.obj in directoriul proiectului.

& ob—¢ x Objectr X | F OBJFilc X | "N OBJExtc X | "% MILEc X | #, Creafific X | B OB/F

C @ editor.pSjs.org ¥ @ Incognito

t Gmail B Maps = Registru evidenta C.. @ GISMETE: Moroga.. H® Xpowmaa Xaoca |P.. R ESP32-CAM Video.. [ Transistor base resi.. [B) SketchUp » | W Other bookmarks Reading st

B B Auviorefresh  Cub s
Upload File
Sketch Files {  sketchjs®
B Cub.obj
B index.html
[ sketch. js
[ style.css

O{
(600, 500,
Q;
(fr);

O {

Console Clear v

Fig. 3.4. Rezultatul procesului de incarcare a fisierului Cub.obj in directoriul proiectului

wind turb



30 OB Fi
&« C & editor.pSjs.org/sirius.c02

t Gmail A Maps = Registru evidenta C.. @ GISMETE: Moroga-. H® XpowukaXaoca|P.. R ESPI2-CAM Video.. [ Transistor base resi.. () SketchUp

p5" File v  Edit Help Er Hell
» | | B Auto-refresh  Cub

Sketch Files v £  sketchjs*®
B Cub.obj

B index.html

B sketch. js

[ style.css

(O

(600, 500,
Q;
(fr);

0O {

Console

Fig. 3.5. Rezultatul executiei programului de afisare a modelului 3D a cubului

Crearea unei scene statice 3D

Sarcina lucrdrii de laborator constd in conceperea si construirea unei scene statice 3D cu
ajutorul editorului online p5.js utilizAnd modele de obiecte 3D stocate in fisiere .OBJ create individual
sau descarcate din internet.

Pentru exemplificarea mersului lucrarii de laborator nr. 3 se pune ca scop crearea unei scene
statice care ar reprezenta o moara de vint ingradita de un gard in ograda careia se vor afla cateva
animale domestice, un arbore si un stog de fan. Modelele 3D ale acestor obiecte pot fi create de la
zero sau importate din repozitoriul 3D Warehouse care poate fi accesat din meniul de baza al
editorului grafic 3D Google SketchUp Window->3D Warehouse, apoi editate dupa necesitate.
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Fig. 3.6. Accesarea repozitoriului 3D Warehouse
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Fig. 3.7. Cautarea modelelor 3D in repozitoriul 3D Warehouse
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Pentru a avea posibilitatea de a downloada sau importa modelul selectat in sketch-ul curent
utilizatorul trebuie sa dispund de un cont Google Account si sa fie autentificat in mediul 3D
Warehouse. Dupa ce a fost downloadat modelul/modelele necesare, acestea pot fi editate dupa
necesitate si exportate ca figiere .OBJ prin intermediului plug-inului LIPID OBJ Exporter care poate
fi instalat din meniul Window->Extension Warehouse (fig. 3.7), in cdmpul de cautare al caruia
indicam cuvantul cheie OBJ iar ca raspuns sunt afisate plugin-urile care satisfac criteriile de cautare
printre care poate fi observat si plugin-ul cautat LIPID OBJ Exporter (fig. 3.9). Pentru a avea
posibilitatea de a instala plugin-urile, utilizatorul trebuie sa dispuna de un cont Google Account si sa
fie autentificat in repozitoriul online Extension Warehouse.
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Fig. 3.8. Accesarea optiunii Extension Warehouse din bara de meniu

9



o

File Edit View Camera Draw Tools Window Extensions Help

-“ "W | 9 Extension Warchouse x §| @ & @ % E

¢

3% Extension Warehouse  #icawsores «  onf Q &

Version 2019 - .
M g
‘. ’ Ak A
Legacy - ‘ o T v
skimp

EXTENSION TYPE

AeiLynejaq

® -
2 <
@ 09GOS |Ce DD B I

| @ W)
9

SimLab OBJ im... QuadFace Tools AUGmentecture Skimp

oNem\

Q

Free Extensions -
‘3. @ 359,399 Views Free
Paid Extensions 277, Free 8,524 Views Free Free
cE
o~ RBZ
Listing Pages
g Y
y h 4
L 4

Reset Filters
LIPID OB]J Expo.

X &
2 g =

- ¥

!

1 ® @ | Dragwindow area to zoom to | Measurements
Fig. 3.9. Fereastra de cautare si instalare a plugin-urilor, din repozitoriul online Extension
Warehouse

3

o

File Edit View Camera Draw Teols Window Extensions Help

w RN NI S eSdEEde Dl FGE = @ OR[GO
[t e

&

‘Ei

U= o @
g
ko LA 2
. i .
)
- = 7 Save Obj File =
e S A s ThisPC » Desktop » Models » v o O Search Models
D E‘ [s] New fold = (2] ﬁ
rganize v ew folder =4
T 1 ~
© o B ot # % e Dmemoges | ype O
7 i Pictures 8 Cub.obj 0 52 2D Object =
ulie &) Fan.obj 3D Object
3 T nie @ Fence.ohj 3D Object @
&) Ground.obj 3D Object
Models = ™ ! O
& &b 8 Horse.obj 3D Object
o WidPump & Sheepl.obj 30 Object
ot & OneDrive & Sheepl.obj 3D Object @
H ’/@) @) Stack.obj 3D Object
5 This pC [8] Three.obj 3D Object 0
ﬁ {'\ B 3D Objects [@ Windmill.obj 3 ED 3D Object O
Deskt v < >
@ [ Desktop e
* File name: | Fan.cbj -
K 'l Save as type: |Wavefront (".obj) v ®
® e Folders [ ][ Gonee ®
vy i . =
X q -
g =
R

©9

| Measurements

Fig. 3.10. Fereastra de salvare in format .obj a modelelor 3D a obiectelor din scena
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Fig. 3.11. Optiunea de ignorare a fetelor a plugin-ului LIPIDOBJ la exportarea modelelor 3D in
format .obj

9

W

Fan.obj - 3D Viewer - X
File Edit Tools View Help Sp 3D library &) Mixed reality @) Off

w E A

Environment & Lighting

Themes v

d om
4 om on

owu «u

Load settings

Light Rotation v

oS

=® Quick Animations A x 1.0 7

Fig. 3.12. Vizualizarea continutului fisierelor .OBJ cu ajutorul aplicatiei standard din cadrul
sistemului de operare Windows 10 — 3D Viewer




Fig. 3.13. Rezultatul executiei programului de afisare a scenei statice

Lucrarea de laborator nr. 3
Tema: Scene statice 3D

Scopul lucrarii: Obtinerea cunostintelor practice in sinteza scenelor grafice 3D statice,
utilizand functiile standard de reprezentare a modelelor 3D din biblioteca p5.js.

Sarcina lucrarii:



1. Elaborati un program pentru sinteza unei scene 3D statice care ar contine cel putin 5 obiecte
utilizand functiile standard de reprezentare a modelelor 3D din biblioteca p5.js.

2. Elaborati un program care creeaza o scend 3D statica conform variantei indicate in tabelul
3.1. Pentru crearea scenei pot fi utilizate obiecte grafice 3D existente n repozitoriul 3D Warehouse.

Tabelul 3.1. Variantele pentru realizarea lucririi de laborator

Nr | Obiect 3D Model Nr | Obiect 3D Model
Morisca
1 Carusel 6 de vint
Far Turbina
2 " 7 Lo
maritim eoliana
Automobil .
3 blindat 8 | Elicopter
4 Moarfl de 9 | Submarina
apa
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